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Informations :

- Sur la version du logiciel recu, les
essais en réel sur un ATV32 n’étaient
pas réalisables, ainsi cette aide en
ligne reprend les infos connues a ce
jour.

- La mise en page n’est pas définitive.
La nouvelle charte sera appliquée lors
de la saisie PAO.

-Pour les informations surlignées en
jaunes nous attendons les
précisions ou confirmations de la
part du projet
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Overview of Function Blocks

The Logic function provides a graphic programming based on predefined function blocks.
The graphic programming is FBD language (Function Block Diagram), and there is a range function
blocks: timer, counter, logic, etc.

The program in the edit window corresponds to:
e Compiled program,
e Program transferred in the ATV32.

To create an FBD (Function Block Diagram) program, insert various function blocks in the wiring
sheet, and link them together.

All types of function blocks can be placed on the sheet, except for the inputs and the outputs.

The edit window is made up of three zones:
e The wiring sheet, where the functions that make up the program are inserted,
e The Inputs zone on the left of the wiring sheet where the inputs are positioned,
e The outputs zone on the right of the wiring sheet where the outputs are positioned.

The following figure shows an example of a part of an edit window in FBD language:
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1) Function block input zone. 6) Links between two function blocks.
2) Connection. 7) Function blocks number.
3) Function block. 8) Function block Output zone.

4) Wiring sheet. 9) Palette pan

5) Comments.
The Function Blocks provide a graphic programming based on predefined function blocks.
In Function Blocks, there are three types of task:



The PRE task is executed in priority because it will reformat the
inputs and motor control.
Pre The cycle of the task is set to 2ms.

The Post task is executed in priority because it resort information
related to motor operation.
Post The cycle of the task is set to 2ms.

The AUX task runs in the background task because it deals with the
heavy actions.

Aux It can be slowed by using communication.
ADrive Applicative Fix execution period
Task (2ms)

Drive Background

Task
Legend:
PRE
< > POST
AUX execution time
is variable. Background (without AUX)
AUX in background

The Pre and Post task are executed on average each 500us and can not exceed 2ms. This leaves an
average of 1ms for perform the task Aux. The task is executed the maximum of time, during the time allotted.
But if the task exceeds 1ms it will perform several times.



Creating a FBD application in the Function Blocks
Insertion of function blocks

To add a function blocks, drag the function blocks that you wish to add on the workspace.

Creation of Input or Output

An input or output is a virtual port. It can be moved along the side of the wiring sheet.

1) Input port

2) Output port

There are 2 types of input / output virtual analog and the register.

The type of the block can be configured by double clicking on it.

[Logic input 1 assignment] (ILO1) to [IL10] (IL10): function blocks logical input,
[Analog input 1 assignment] (IA01) to [IL10] (IA10): function blocks analog input,

[Logic output 1 assignment] (OLO1) to [OL10] (OL10): function blocks logical outputs,
[Analog output 1 assignment] (OA01) to [OA10] (OL10): function blocks analog outputs.

When you double click on a virtual port, only this port can be changed, the others are grayed out.

For example, configuration of the input 3:

al Po pnfiguratio

Part Data Type Wirtual Mumber A
& 1 Mot implemented % |1
Dizcrete 0
Analogic
1 i 0
|4 Mot implemented w0 _\
1) Choice of the da_ta type, I5 Notimplemented [+, 0
2) Number of the virtual output. ,
|6 Mat implemented | 0
|7 Mat implemented w0
|8 Mat implemented w0
19 Mat implemented % | 0
110 Mot implemented w0
~

0K ] [ Cancel




Links between Function Blocks

Position the function blocks in the wiring sheet, then link them together. Link one block output to an input of
another block or loop an output back to an input of the same block.

The following procedure describes how to link function blocks together:

1. Left click on an output of a function block.
Result: the mouse cursor is displayed as a cross.

()
Rty

- MUL /DI

W N

Keep the left button held down.

2. With the button held down, move the cursor over a block input.
Result: the mouse cursor is displayed as a cross.

3. If the cursor turns into a circle with a line through it when you move it over a block input, this means
that the link destination is incorrect (incompatible types).

e |f the connection is available, the cursor is —|_

e |f the connection is forbidden, the cursor is @

Release the mouse button.
Result: The line is shown between the two linked blocks.

Repeat steps 1 to 3 to link all the blocks.



Function Blocks configuration

Function Blocks configuration

Each of the function blocks has a configuration window. This window consists of one or two tabs:

e Comments for all function blocks,
e Block number,

o Parameters depending on the function blocks type (FBD PRESET COUNT).

When you double click on a function block, a configuration windows appears.

1) Comments tab:

All of the function blocks can have an associated
comment. These comments are displayed under the
block in the wiring sheet.

In the Comment zone you can enter a comment of up
to three lines of a maximum of 90 characters
maximum.

2) Display block number:
Display the block number permanently.
This option is activated by default.

3) Display comment:

When a comment has been added to a function block,
If the “Display comment” box is checked the comment
is permanently displayed.

4) Parameters tab:

Most function blocks have a parameters tab. In this tab, you have to set the function block's specific

BlankBlock

Comments | Parameters

Dizplay block number
Dizplay comment

I ak. H Cancel ]

parameters. These parameters are described in detail in the help for each of the blocks.



Configuration: Input or Output

Each Input or Output has a configuration window.

With a double click on the departure or arrival } a configuration window appears.

Comments tab:

These comments are displayed under the block in the wiring
sheet.

In the Comments zone you can enter a comment of up to
three lines of a maximum of 90 characters maximum.

Display block number:
Display the block number permanently.
This option is activated by default.

Display comment:

When a comment has been added to a function block,

If the “Display comment” box is checked the comment is
permanently displayed.

Configuration

Comments

Display block number
Dizplay comment

ok Cancel
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Type of Link

The link is displayed in different ways depending on the type of data transferred

e For a Boolean link it is a Black line (Boolean signal):
0 Possible value: 1 or 0.

e ForaS16linkitis a Green line (analog signal): s
o Possible value: -32768 to 32767.

e ForaU16 linkitis a Blue line (register signal): s
0 Possible value: 0 to 65535.

Display Options

Palette panel

To create an FBD program, the different possible functions are available in the palette panel.
Each picture in the palette panel represents a function type.
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When the mouse is moved over one of the function type, the name of the function is view.
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Menu bar

For Logic functions, several different options are

available:

Import / Export
o Export
0 Import
Edition
Cut
Cancel
Select all
Find
Set / View execution order
Reset execution order
Check the application
Align left
Align center
Align right
Align top
Align middle
Align bottom
Horiz. spacing
Vert. spacing
Bring to front
Send to back

O0O0O0O0O0OO0OO0OO0OO0OO0OOO0O0OOO0OO

o Simulation

o—itRun
o—Pause
o—Stop
o—PowerOFF
o—APAiew

Mode
o Edit
o Monitor
o—Simulate
ATV
o ATVcontrol
0 ComparePCtoATV
0 DeleteATVapplication
Zoom
Preferences
Configure
Password

Device | Tools  Help

Comrand Panel
Factory Setkings

Configuration

ATW12 HMI Personalization

Protection

ATVLogic

Import | Export
Edition
Sirnulation
Manitaring
Maode

ATY
Preferences
Configure

ATYLaogic Password

* ¥ ¥ v ¥ ¥
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Import / Export:

Export
Waiting information

Import
Waiting information

Edition

Cut:

This feature is accessible via the menu bar: Function Blocks - Edition = Cut, it allows you to cut one or
more selected objects, it is too accessible with the ) icon.

Cancel

This feature is accessible via the menu bar: Function Blocks = Edition - Cancel, it allows you to cancel
the last action perform. It is too accessible with icon.

13



How to select, deselect and delete one or more blocks?
How select one isolated block:

By clicking on isolated block function with the left-click of the mouse. Extend the selection to another block,
the old block will be deselected.

To add an element to the selection, hold the key “SHIFT” and click on an element.

How select more objects:

To select several contiguous objects, Frame the objects to be selected by defining a selection zone.

To select several objects scattered about in the wiring sheet, press the Shift key, then click on the objects to
be selected while continuing to hold down the Shift key.

How deselect one or more block:

By clicking on a free area in the wiring sheet or press the Escape key, all the blocks will be deselected.

To deselected one block of the selection, press the Ctrl key and click on the objects that you want to
deselect.

14



Find:
The find feature allows searching in: comments, function blocks, block number.

This function is accessible via the menu bar: Function Blocks = Edition = Find.

AtvlogicFind

Find what :

|BD1 | Find next
[] Match case

[ Matzch whole waord

Once the research started, when a block meets the search criteria, it will be marked in blue.
To see the other blocks that could meet the criteria, click again to find next.

BO0

15



Set / View execution order:

This feature sets the order execution of the function blocks.

This function is accessible via the menu bar: Function Blocks = Edition = Set / View execution order.

@ Set £ Yiew execution order

Pre Taszk
BOO

EBO1

BOZ

Post Task
BOO

B

BOZ2

Auge Taszk,
BOO

BO1

BO2

ok || cancel |

To restore the default values see “Reset execution order”.

Reset execution order:
This feature resets the order execution of the function blocks.

This function is accessible via the menu bar: Function Blocks = Edition = Reset execution order.



Check the application:

With the Edit > Compilation command or & you launch the compilation (check) of the program. The
result of the compilation is displayed in the compilation report window. In this window, the following
information appears:

e The result of the program check,

e Resources used and available.

Results Window Elements
The compiler calculates the volumes of resources used in the drive.

If the values calculated are greater than the available values, they appear in the compilation report window.

The compilation report window displays the various possible errors recovered by compiling

(& com pilation Report El

COMPILATION SUCCEEDED (0 error(s), 0 warning(s})

ALbout the program

Available

f the application (bytes] 100
Diuration of the PRE and POST tasks [us] 0 200
Diuration of the AL task [ps) o 1000000

Lbout the compilation

Error | waming

N errar

List of errors:
Test Error type Consequences
The destination file can’t be Error stop the compilation
opened
The internal parameter has no Warning the value is set to 0 by default
value
At least one virtual input block is Error /
present but no input block is
connected
At least one virtual output block is | Error /
present but no output block is
connected
2 FB have the same execution Error Normally prevented by HMI
order
2 inputs or outputs block have the [Warning /
same ID
1 input of a FB is not connected Warning the value is set to OxFF
1 output of a FB is not connected | Warning the value is set to OxFF
Memory overflow Error /
Pre + Post duration Error /
Aux duration Error /
Binary file too large Error /
RAM allocation exceed Error Not treated yet
ADL container used more than 1 Warning Not treated yet
time
FB that have inputs but no one Error /
connected

17




Manipulating FBD objects

How to Align a Group of Objects

Select the objects to align.

Result: All of the selected objects are highlighted by small yellow squares placed at each corner of the block.

From the Align command in the Tools menu, select:

Icon Title Description

Align left Align the group of block vertically to the left.

EI Align center Align the group of block vertically to the center.
Align right Align the group of block vertically to the right.

ol | | Align top Align the group of block horizontally to the top.
@ Align middle Align the group of block horizontally to the middle.
Align bottom Align the group of block horizontally to the bottom.

How to Center a Group of Objects

Select the objects to center.

Result: All of the selected objects are highlighted by small yellow squares placed at each corner of the block.

From the center command in the Tools menu, select:

Icon Title Description
Horizontal
spacing Center the group of block horizontally, equally spaced.

Vertical spacing

Center the group of block vertically equally spaced.

How to Bring or Send an object to the Foreground or Background

Select the objects to bring or send.

Result: One or all of the selected objects are highlighted by small yellow squares placed at each corner of

the block.

From bring or send command in the Tools menu, select:

Icon Title Description
IEI BringToFront Bring an or the group of block to the foreground.
IEI SendToBack Send an or the group of block to the background.

18



InitRun
Pause

Step
PowerOFF

APV iew

Monitor

Mode:
Edit

Monitor
Simulate

ATV:

ATVcontrol
ComparePCtoATV
DeleteATVapplication

Zoom:

This function is accessible via the menu bar: Function Blocks = Edition - Zoom.

It gives you the choice whether to display the zoom window.



Preferences:

This function is accessible via the menu bar: Function Blocks = Preferences.

This feature edits:

o Workspace,
e Functions,
e Check report.

Workspace:

- Display or not the grid

- Choose the size of spaces
- Choose the zoom.

Functions:
All function blocks can have an associated comment
and block number. They are shown above and below
the function block in the wiring sheet.
You can choose to display:

e All comments,

e All numbers.

Preferences
Workspace
Diisplay grid
Furctions
Display comments Dizplay Mumbers

Check report

FREtaskCPUme [0 | AlXteskCPUtme [0 |
POST task CPU t\mal:l temary uzed l:l
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Configure:

This function is accessible via the menu bar: Function Blocks = Configure.

This window has two tabs:

e Application information,
e Tasks.

Application information:

This tab lets you enter information related to the
program:

* The name of the Programmer,
* The version,

* The date,

* And a comment.

Tasks:

This tab specify the maximum time authorized for
the conduct of the stain AUX.

This can be likened to a WATCHDOG action
(module cycle time control).

& configuration E]

Application Information ‘ Tasks
tain
Author | ‘
Vewion 0| Date(MMDDY YY) 12022008
Comment
) Configuration E|

Application Infamation | Tasks |

PRE & POST

PRE/POST max duration (ms)
Al

Period duration I:I [mz]

21



Function Blocks Password:

This function is accessible via the menu bar: Function Blocks = Function Blocks Password.

Define the password, which prevents the reading of your program.

X

@ Password

Passwaord

Disfine the password (0001...9999) ]

OF. ] [ Cancel




Wiring sheet dimensions

It is possible to change the dimensions of the wiring sheet.

Resize the wiring sheet by clicking on the right side of it and drag it to the left or right.

[

2. s ERP R
I2 & Sl o lloh 2 &% %
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FBD language elements

Special Inputs Function

NUM
constant) NUM (Signed)

The numerical constant NUM is an integer signed with a value between -32768 and +32767.
This constant can be used to set values to the functions’ non-connected inputs:

e GAIN,
e COMP IN ZONE,
¢ TRIGGER.

The value of the constant can be set in the
Parameters window.

In Simulation or Monitoring modes, it is possible to
modify the constant.

NUM
constant’ NUM (Unsigned)

BlankBlock

Camments | Parameters |

Walue of the constant

[-327E8...32767)

[1]4 ] ’ Cancel

The numerical constant NUM is an integer unsigned with a value between O and 65535.

The value of the constant can be set in the
Parameters window.

In Simulation or Monitoring modes, it is possible to
modify the constant.

BlankBlock

Comments Parameters|
Yalug of the constant
[0...65535)
QK l [ Cancel

24



b

TRUE

L COMSTANT.- TRUE

This constant can be used to set the function inputs to 1.

In Simulation or Monitoring modes, you can force these inputs in the reverse order.
_-'_'\-

FALSE
voanesTahT FALSE

This constant can be used to set the function inputs to 1.

In Simulation or Monitoring modes, you can force these inputs in the reverse order.

25



Logic Function

In FBD language, it is possible to use logic functions in the block diagrams. These functions are accessible

from the Palette panel. The available functions are:

{0
m The NO function,

If the input is inactive or not connected, the output is active.
If the input is active, the output is inactive.

> [IN]: A Boolean input
» [Q]: A Boolean output

&
AND ) The AND function,

If all the inputs are active or not connected, the output is active.
If at least one input is inactive, the output is inactive.

» [IN1] to [IN4]: 4 Boolean input
» [Q]: A Boolean output.

L)

The OR function,

If at least one input is active, the output is active.

If all the inputs are inactive or not connected, the output is inactive.

> [IN1] to [IN4]: 4 Boolean input
» [Q]: A Boolean output.

In Q

0 1

1 0
InN1{In2] In3|In4] Q
0]0] 0 0 0
0]1]0] 0 1 0
010 1 0 0
010 1 1 0
011 0 0 0
0|1 0 1 0
0|1 1 0 0
0|1 1 1 0
1 0] 0 0 0
1 0] O 1 0
1 0] 1 0 0
1 0] 1 1 0
1 1 0 0 0
1 1 0 1 0
1 1 1 0 0
1 1 1 1 1
In1{In2] In3|In4d] Q
0]1]0] 0 0 0
0]1]0] 0 1 1
010 1 0 1
010 1 1 1
0|1 0 0 1
0|1 0 1 1
0|1 1 0 1
011 1 1 1
1 0] O 0 1
1 0] 0 1 1
1 0] 1 0 1
1 0] 1 1 1
1 1 0 0 1
1 1 0 1 1
1 1 1 0 1
1 1 1 1 1

26



& D
NAND /The NO AND function,

If at least one input is inactive, the output is active.

If all the inputs are active or not connected, the output is inactive.

» [IN1] to [IN4]: 4 Boolean input
» [Q]: A Boolean output.

The NO OR function,

If all the inputs are inactive or not connected, the output is active.

If at least one input is active, the output is inactive.

» [IN1] to [IN4]: 4 Boolean input
» [Q]: Boolean output.

The EXCLUSIVE OR function.

If an input is inactive and the other input is active or not connected, the output is active.
If both inputs are active or inactive or not connected, the output is inactive.

> [IN1] and [IN2]: 2 Boolean input
> [Q]: Boolean output.

In1 In2 In3
0O 0 O
0O 0 O
0 O 1
0 O 1
0 1 0
0 1 0
0 1 1
0 1 1
1 0 O
1 0O O
1 0 1
1 0 1
1 1 0
1 1 0
1 1 1
1 1 1
In1 In2 In3
0O 0 O
0O 0 O
0 O 1
0 O 1
0 1 0
0 1 0
0 1 1
0 1 1
1 0 O
1 0 O
1 0 1
1 0 1
1 1 0
1 1 0
1 1 1
1 1 1

5

=
=1

- O -0

o= 200

n4

-0~ 0~ 0~~r0~~r0~~0-~~0~-~0

=
~

-~ 0 -~ 0 ~r0r0~~r0~~0~0-~-~0

o_\_\_\_\_\_\_\_\_\_\_\_\_\_\_\,o

[eNoNoNoNoNoNoNoNoNoNoNolleoNeNalwWe)
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TIMER ./ TIMER A/C (Timer)

The Timer function is used to delay, prolong and control actions over a predetermined time.
The Timer has three functions:

o The A function: timer on-delay, or timer active,
e The C function: timer off-delay, or timer idle,
e The A/C function: combination of functions A and C.

Inputs/Outputs:

» [IN]: A Boolean input,
» [Q]: A Boolean output.

Configuration

Configuration:

Comments | Parameters

From the Configuration window, you can adjust in Toee

Parameters tab: £ v

In the Parameters tab, you can adjust the value of the
delays for each of the functions (A, C and A/C).
e ON delay for function A,
e OFF delay for function C, L v
e A combination of both the ON and OFF (0. 655357 01 <]
delays can be used to adjust function A/C. OFf delay

On delay

il Fa

-

(0...65535 % 0.1 5

[ ok || concel

A Function

The following diagram shows the operation of the timer in function A:

i
[IN] : |
@l - :
R
OM delay

28



C Function

The following diagram shows the operation of the timer in function C:

—
OFF delay

Note: Each pulse on the Command input of the Timer block resets the current value to 0.

A/C Function

The following diagram shows the operation of the timer in function A/C:

i
S S e B
@ | R o
O dely SEF™ L<ON delay t=OFF
delay delay
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oofsus’ ADD/SUB (ADD/SUB Arithmetic Function)

The ADD-SUB arithmetic function is used to perform simple operations on integers:

e Addition,
e  Subtraction.

Calculation formula:

CALCULATION OUTPUT [Q]= [A] + [B] - [C]

Inputs/Outputs:
Description of the inputs:

» [A]: A signed input (S16: analog),
» [B]: A signed input (S16: analog),
» [C]: A signed input (S16: analog).

Note:
If the inputs are not connected, they are set to 0.
It is not possible to do mathematical operations on registers.

Description of the outputs:

» [Q]: Signed output (S16: analog): this is the value of the calculation formula output.
» [Overflow]: This output, whose type is Boolean, indicates any presence of saturation errors.
This output is activated in the following cases.

0 Result not included in the interval [-32768, +32767]

o0 The Error propagation input is active.

Examples:

Addition: do not use the Input [C].
Subtraction: do not use one of the [A] or [B].
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BOGLEAN [ Boolean Function

The BOOLEAN function gives the value of the output according to the combination of inputs.

The function has four inputs, and therefore 16 combinations. These combinations can be found in a truth
table; for each of these, the output value can be adjusted. The number of configurable combinations
depends on the number of inputs connected to the function.

Non-connected inputs are set to 0.

The following diagram shows an example of part of the Boolean function truth table:

Inputs/Outputs:

> [IN1], [IN2], [IN3] et [IN4]: 4 Boolean inputs.

» [OUT]: A Boolean output.

Configuration:

) Configuration

Comments

Parameters

From the Configuration window, you can adjust in
Parameters tab:

IN1 INZ IN3 N4 out

Having connected at least one input, configure the
value of the output in the truth table, in the
Parameters window.

The output values can be 0 for the Inactive state,
and 1 for the Active state.
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= CAN (Word to Bit Conversion)

The Word to Bit Conversion function breaks down an integer-type input (16 bits) into 16 bit type outputs. ..

—ie= BITO1
Input [IN] e piToz  Output [QxX]
| CAN —ie= BITO3
16 Bit word 16 Bit
—= BIT15
—m= BIT16
Inputs/Outputs:

» [IN}: A unsigned input (U16: register),
» [QO01] to [Q16]: 16 Boolean outputs: Bit01 (least significant byte) ... Bit16 (Most significant byte).

CNA (Bit to Word Conversion)

The Bit to Word Conversion function produces an integer (16 bits) type output from 16 bit-type inputs.

BITO1 —J=
Input [INXX] 3702 — =] Output [OUT]
HTO3 —e CAN >
16 Bit i
— 16 Bit word
BIT16 —f=
Inputs/Outputs:

» [INO1] to [IN10]: 16 Boolean entries: Bit01 (least significant byte) ... Bit16 (most significant byte),
» [OUT]: An unsigned output (U16: register).
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comeare ) COMPARE (Comparison of two values)

This function is used to compare two analog values.

The output [Q] is active if the result of the comparison between [IN1] and [IN2] is true and if the Enable

functions input is active or not connected.

The output does not change state if the Enable function input changes from Active to Inactive state.

Inputs/Outputs:

» [IN1]: A signed input (S16: analog),
» [IN2]: A signed input (S16: analog).
» [ENABLE]: A Boolean input.

If the [IN1] or [IN2] input is not connected, the value is set to 0.

» [Q]: A Boolean Output.

Configuration:

From the Configuration window, in the parameters
tab you can choose the comparison operators:

> Greater than,

> Greater than or equal to,
= Equal to,

# Different,

< Less than or equal to,
< Less than.

Configuration

Comments

Compare

Parameters

Walue 1

= Walue 2

0k

] ’ Cancel
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EDGE J Edge

The function detects falling or rising edge of a signal.

Inputs/Outputs:

> [IN]: A Boolean input.
o Signal tested

> [Q]A Boolean Output.
o Pulse when the edge is detected.

Configuration:

Configuration

From the Configuration window, adjust in Comments | Parameters
Parameters tab the Edge type:
Edage hipe
o Falling
e Rising
e Twice
0k ] [ Cancel
Select In(t) [Int+1)] Q(t)
1 0 1 Edge_Type =1
0 0] 0 3
Falling 1 7 0 n
Twice 0 1 0 '
1 0 0 '_|
. 0 0 0
Q
Rising 1 1 0
0 1 1
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GAIN Function
The Gain function enables analog values to be converted by changing the scale and offset.
Gain calculation formula:
CALCULATION OUTPUT = (A /B) x CALCULATION INPUT + C
Inputs description:

» [IN]: A signed input (S16: analog): This is an integer between -32768 and 32767.

» [ENABLE]: A Boolean input: This is the gain function input command.

The state of this input determines operation of the block: If the Enable Function input is inactive, the
Calculation output retains the last calculated value.

Note: If the Enable Function input is not connected, it is considered to be active.

Outputs description:

» [Q]: A signed input (S16: analog): this is the output value of the gain function.
This value depends upon the state of the Enable function input.

» [OVERFLOWI]: A Boolean Output. Ifitis:

o0 Inactive: the Calculation output is equal to zero,
o0 Active: the Calculation output is equal to the result of the gain calculation formula.

Configuration:

Configuration

From the Configuration window, adjust in
Parameters tab:

Commertz | Parameters

A/B which corresponds to the gain applied by the Giain: y=A/B L
function with: Gain numerator [£) =1 [-32768... 32767
N _h (-32768...32767)
e A: being a numerator (from -32768 to A 2] - and et nul
32767) Offset [C) =0 (-32768...32767)

¢ B: being a denominator (from -32768 to -1
and from 1 to 32767) (4)

o Cis the offset applied by the function, and is
an integer between -32768 and 32767(5).

In addition, it is possible to define an operating
range by setting limits for the function output:

1] ] ’ Cancel

Lower limit: integers between -32768 and 32767,
Upper limit: integers between -32768 and 32767.
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MuLIBY) MUL/DIV (MUL/DIV Arithmetic Function)

The MUL/DIV arithmetic function is used to perform operations on integers:
e Multiplication
e Division

Calculation formula:
CALCULATION OUTPUT = [A] x [B]/ [V]

Inputs description:

» [A]: A signed input (S16: analog),
» [B] A signed input (S16: analog),
» [C]: A signed input (S16: analog).

Note:
If the INPUTS are not connected, they are setto 1.
It is not possible to do mathematical operations on registers.

Outputs description:

» [Q]: A signed input (S16: analog): this is the value of the calculation formula output.

» [OVERFLOWI]: This output, whose type is Boolean, indicates any presence of saturation errors.
This output is activated in the following cases:

The consequence of the operations is a result that is not included in the interval [-32768, +32767],
The Error propagation input is active,

The Input 3 equals 0.

Examples:

Multiplication: do not use the [C] input.
Division: do not use one of the [A] Input or [B] inputs.



MUX (Multiplexing)

The Multiplexing function carries out two input channel multiplexing on the Output.

Inputs description

» [SEL]: A Boolean input: this input is used to choose the input channel to apply to the output.

» [IN1]: A signed input (S16: analog): this is the multiplexer input [IN1].
» [IN2]: A signed input (S16: analog): this is the multiplexer input [IN2]

Note:
If the Command input is not connected, it is considered to be inactive.
If channels [IN1] or [IN2] are not connected, they are set to 0.

Output description:

» [Q]: A signed output (S16: analog): this is the multiplexer output [Q].
This value depends upon the state of the Command input [SEL].

If the Command input is:
0 Inactive: the Output corresponds to [IN1].
0 Active: the Output corresponds to [IN2].
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emresn ) ReadBitParam

The “ReadBitParam” function block is using for read one Bit into parameters.

To read one Bit of drive parameters:
o Use the ADL containers to link with the parameters of the drive.
(See description of the [ADL Containers] (LA01))
To read one Bit of parameters of a communication protocol:
e Use the parameters MOOx to store data. Store values for which they are reused it by the function
blocks and communication protocol.
(See description of the [FB PARAMETERS] (M001))
Inputs/Outputs

» [ENABLE]: A Boolean input,
» [Q]: A Boolean ReadBit output.

Configuration

Comments | Parameters |

ADL container D:

Configuration

From the Configuration window, you can adjust in
Parameters tab:

Bit posgition;

The ADL Container ID will be used and choose the
Bit position.

Ok, ] l Cancel
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READ / ReadParam

The “ReadParam” function block is used for read a value.

To read drive parameters:

o Use the ADL containers to link with the parameters of the drive.
(See description of the [ADL Containers] (LA01))

To read parameters of a communication protocol:

e Use the parameters M0Ox to store data. Store values for which they are reused it by the functions
blocks and communication protocol. (See description of the [FB PARAMETERS] (M001))

Inputs/Outputs
» [ENABLE]: A Boolean input.

» [Q_U16]: An unsigned output (U16: register).
» [Q_S16]: A signed output (S16: analog),

Configuration
From the Configuration window, you can adjust in

Parameters tab:

The ADL Container ID will be used. You can also
select the type of output signal.

Configuration

Comrments | Parameters

ADL contaiter 10

Drata type:

& U1E

4

O 516

oK

| [ cancel
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RS memory

The SET RESET function operates as follows:

e Activation of the SET input activates the output, which remains so even if the SET input is then

deactivated,

o Activation of the RESET input deactivates the output.

Non-connected inputs are set to the Inactive state.

Inputs/Outputs

» [SET]: A Boolean input,
» [RESET]: A Boolean input,
» [Q]: A Boolean output.

Configuration:

From the Configuration window, you can adjust in
Parameters tab:

If both inputs are active, the state of the output
depends on the configuration of the function:

e The [Q] output is active if the [SET] has
priority option is configured,

e The [Q] output is inactive if the [RESET]
has priority option is configured.

Configuration

Comments | Parameters

Fricrity

() SET has priority

(=) RESET has priority

0K

| [ cancel

e —
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Botl J shift/Roll

The function allows to shift or rolls to the left/right, the [IN] value of a fixed number of bits.

At each cycle if the [Enable] signal is set, the logic block will perform a shift/roll to the left/right to the Number
Bit request regarding the parameters configuration.

SHIFT move bits in the selected direction and replace empty bits by 0.

Note: It is impossible to lag records on analog values.

Inputs description:

» [IN]: An unsigned input (U16: register).
» [ENABLE]: A Boolean function input,

Outputs description:

» [Q]: A unsigned output (U16: analog),

» [CARRY]: A Boolean output.
The carry output tells you the value of the last bit shifted.

Configuration:

Configuration

From the Configuration window, you can adjust in Comments | Parameters
Parameters tab: Mode
@ SHIFT O ROLL
e The mode: Shift or Roll. —
Irechion
e The direction: Left or right.
e The number of bits. O Left @ Right
Humber of bits 1] E
0K ] ’ Cancel

41



TRIGEER ) TRIGGER (Schmitt Trigger)

The Schmitt Trigger function allows an analog value to be monitored relative to two thresholds.
The output changes state if:

e The [IN] value is less than the minimum value,
e The [IN] value is greater than the maximum value.

If the [IN] input is between the two, the [Q] output does not change state.

Each of from On to Off and from Off to On setpoints can be set as the minimum or maximum value. This
involves reverse operation of the function. These two operations are shown in the diagrams.

If the [Enable] input is in inactive state, the [Q] output remains inactive. The [Q] output does not change state
if the [Enable] input changes from Active to Inactive state.

Inputs/Outputs:

» [IN]: An Integer Off and On setpoint input,
» [ENABLE]: A Boolean input

.> [Q]: A Boolean Output.

Configuration

Configuration:

Carmments | Parameters
From the Configuration window, you can adjust in Start threshold
Parameters tab: - _
(0...55535)
e Start threshold,
e Stop threshold. Stop threshold
o g
[0...E5635)
Ok ] [ Cancel
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Operating Diagrams:

The figure shows possible output states when the On to Off setpoint is higher than the Off to on setpoint:

[ENABLE] ¢
[1 | | | .
Va|LEtD‘EE
N AN A
=
o I =,

The figure shows the possible output states when the Off to on setpoint is higher than the On to Off setpoint:

[ENABLE]

OO [ [

Walue o 1
COMpE e

N AWAYA

[IN] k‘—?/ ;
[Q] | | [ 1,
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RESET

counT./ UP/DOWN and PRESET COUNT

The Up/Down Counter function is used to up-count or down-count from a preset value resulting from a
calculation outside the function.

Inputs:

[UP]: A Boolean Up-Count input,
[DOWN]: A Boolean Down-Count input,
[RESET]: A Boolean input,

[LOAD]: A Boolean input,

[PV]: An analog Preset value input.
[ENABLE]: An input,

VVYVVVY

Outputs:

> [Q]: A Boolean Output,
» [CURRENT]: The current counter value.

Several functions are available:
e Up-counting and forcing the counter to 0 on initialization,
e Up-counting and forcing the counter to 0 on initialization and when the count value has been
reached,
e Down-counting and forcing the counter to the preset value on initialization,
o Down-counting and forcing the counter to the preset value on initialization and when 0 has been
reached.

Activation to 1 of the [LOAD] input is used to change the counter with the value available at the [PV] input.

The [PV] input can be connected to an NUM constant, to an analog input, or to any other kind of function
block output which delivers an signed-type value.
A rising edge on the:

e Upcounting: increments the counter.

o Downcounting: decrements the counter.

State of the Output:

Is at 1: When the counting number has been reached, the [Q] output switches to 1 and remains so for as
long as the counting number is greater than or equal to the [PV] Preset value,

Is at O: If the transitions on the Downcounting input switch the counting number back to a value less than the
Preset value.

Activation of the [Reset] or [LOAD] inputs enables the counter to be relented.

When the [Reset] input is set to 1, the [Q] output remains in state 0. When the [Reset] input becomes 0, the
up/down counting operation is restarted from zero.
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For the following four charts, the blue curve represents the internal counter value, when it increases there
are pulses on the upcount input and when it decreases, pulses on the downcount input.
The following diagram shows the operation of the counter with initialization at 0:

Up-Counting in Single Cycle Mode:

[RESET] M

=
| a8

A T

[CURRENT]ﬁ'] /_A_\ v /

Q- 1 1 [

¥

Down-Counting in Single Cycle Mode:

The following diagram shows the operation of the down-counter with initialization at the preset value:

[RESET]
[] .

[CURRENT] & va2767

@ i I o B e
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Up-counting in Repetitive Cycle Mode:

The following diagram shows the operation of the counter with forcing to 0 of the [CURRENT] current value
on [RESET] initialization, or when the count value has reached the [PV] preset value:

[RESET] T

[ 1,

k +ETET

[CURRENT]f— 1 L4 I,

u

= = on
+—

L J

The [Q] output switches to the Inactive state when the predefined pulse duration value has run out. If the
switch condition is Active before switching to the Inactive state, the output pulse is extended by the Duration
of pulse (Timing).

Down-Counting Function in Repetitive Cycle Mode:

The following diagram shows the operation of the down-counter with forcing to the [PV] preset value of the
[CURRENT] current value on initialization, or when the count value has reached 0:

[RESET] ¢

[] 1,

[CURRENT] o HITET

Fy
) [ ] (B N,
A o
tirming tirming
n
Tirne =
tirning

The [Q] output switches to the Inactive state when the predefined pulse duration value has run out. If the
switch condition is Active before the switch to the Inactive state, the output pulse is extended by the Duration
of pulse (Timing).
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errwrrre) WriteBitParam

Description

The “WriteBitParam” function block is using for write one Bit into parameters.

For write one Bit of drive parameters:

You must use the ADL containers to link with the parameters of the drive. (See description of the [ADL
CONTAINERS] (LAo1)

Note:
When a backup in EEPROM is being, the “WriteBitParam” are no longer operational.

For store or reused a value:

The parameters M0Ox are easy to use to store data. You can store values for which they are reused it by the
functions blocks and communication protocol. (See description of the [FB PARAMETERS] (Mo01))

Inputs/Outputs
The WriteBitParam uses:

> [IN]: A Boolean WriteBit input,
» [ENABLE]: A Boolean input.

Configuration

Configuration: Cormments| Patameters
. . . . . ADL container D il e
From the Configuration window, you can adjust in
Parameters tab: . —
Bit position: a )
In the parameters tab you can choose the ADL
Container ID will be used and choose of Bit
position.
ar. ] ’ Cancel
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WRITE ./ WriteParam

Description

The “WriteParam” function block is use for write or store a value.

For write drive parameters:

You must use the ADL containers to link with the parameters of the drive. (See description of the [ADL
Containers] (LAo1))

Note:
When a backup in EEPROM is being, the “WriteParam” are no longer operational.

For store or reused a value:

The parameters M0Ox are easy to use to store data. You can store values for which they are reused it by the
functions blocks and communication protocol. (See description of the [FB PARAMETERS] (Mo001))

Inputs/Outputs
» [IN_U16]: An unsigned input (U16: register).

» [IN_S16]: A signed input (S16: analog),
» [ENABLE]: A Boolean input.

Configuration: & configuration

Camments | Parameters

From the Configuration window, you can adjust in
Parameters tab: ADL container 10 0

4r

Data type: ® U1E ) 518
In the comments tab you can choose the ADL

Container ID will be used. You can also select the
type of input signal.

] l [ Cancel
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4 STU (Signed 16bits TO Unsigned 16Bits)

Description

The “STU” function block is use for convert a signed 16 Bits to an unsigned 16 Bits.

Signed input range: -32768 to +32767.
Unsigned output range: 0 to 32767.

Inputs/Outputs

» [IN]: A signed input (S16: analog).

» [Q]: An unsigned output (U16: register),

» [OVERFLOW]: An Overflow output.
The Overflow output is of Boolean type, this output is set if, the input signed value is negative, the output

unsigned value will be set to 0 and the Overflow.
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~ =ret; UTS (Unsigned 16bits TO Signed 16Bits)

Description

The “UTS” function block is use for convert an unsigned 16 Bits to a signed 16 Bits.

Unsigned input range: 0 to 65535.
Signed output range: -32768 to +32767.

Inputs/Outputs
» [IN]: An unsigned input (U16: register).

» [Q]: A signed output (S16: analog),
» [OVERFLOW]: An Overflow output.

The Overflow output is of Boolean type, this output is set if, the input unsigned value is over 32767,
the output signed value will be set to 32767.
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Communication with Altivar

Communication option

Configuration of connection

To establish communication between the Function Blocks via SoMove and the ATV 32, one of the following

links may be used:

e Serial link: Com port
e Bluetooth link: Com port

Before launching the connection between Function Blocks and the ATV 32, the following must be checked:

In the case of... | Make sure that:

Serial link
The smart relay is physically connected to the SoMove
(PC),

The connection is correctly configured.

Bluetooth link
The bluetooth of the ATV 32 is actived from the
parametre [Bluetooth Activation] (btUA) = [ON]
(On).

Note: The driver associates a com port to the adapter.

Program Import

The File 2 Import command and = is used to import a program

An entire program,
e One or several contiguous lines,
e One or several contiguous cells.

Following each import, an automatic program check is performed.
Following each import, you are advised to launch the Edit > Check the program command.

Note: It is possible to import a subset of an FBD program usingcopy and paste.
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Parameters of communication

Description of ADL Containers
The ADL Containers are linked to 4 function blocks

e ReadParam,
e WriteParam,
e ReadBitParam,

e \WriteBitParam.

Because, those function blocks are linked to ADL container (by configuring a blocks parameter name
“Container ID”). This configuration is done during graphical edition of the program in Function Blocks.

There are 8 ADL containers used to connect %MW, %SW, or other drive parameters.

Ajouter un lien vers le guide des parametres ADLC

Code Lang Lahel Current Value
[T— =
T w ADL Containers
et [Tg ; | G o GanoD
Dts by = UM L1 L.'&J:IE n I-I
LADS Code /Lnng Label Current Walue
A4 w P Parameters
" oy 0
Are
= ol [
[ nean J 2 hAOO3 0
- - kD04 0 0

Depending on which task the Read/WriteParam logic block is implemented, it will allow connection to Fast or
Slow parameters.

The rule is:

o In PRE/POST tasks: Connection to Fast access parameters only.

e |n AUX task: Connection to Slow and Fast access parameters.

4 groups of parameters are defining:

FB Read fast (for PRE/POST tasks)
FB Read slow (for AUX task)
FB Write fast (for PRE/POST tasks)
FB Write slow (for AUX task)
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FB SYSTEM WORDS

[FB SYSTEM WORD 01] (S001)

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

TB1MIN: [(TB1SEC:

Clock bit: | Clock bit: | TB100MS : Clock

period period 1s, |[bit: period 100ms, |Reserved |Reserved |Reserved |Reserved |Reserved

1min, duty |[duty cycle [duty cycle 50%

cycle 50% |50%

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8
1RSTSCANRUN :
FB is executing its

Reserved |Reserved ;rSthycle since last Reserved |Reserved |Reserved [Reserved |Reserved
Used only in PRE
and POST

Staje
Bits 5, 6 and 7 description:
1
An internal timer regulates the change of
states of the bit. 0 . B -
+—r Time
Period  Period /2

Bits 13 description:

The portion of mode STOP to RUN mode (even after a cold start) is reported by setting 1 of %S13 system
bit. This bit is reset to 0 at the end of the first cycle of the POST task in run mode.

[FB SYSTEM WORD 06] (S006)

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Reserved Reserved |Reserved Reserved |Reserved |Reserved |Reserved |Reserved
Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8
USRMWSAV
E : Users
Reserved Reserved |variable save |Reserved |Reserved |Reserved |Reserved |Reserved
request (=CMI
bit 15)

Bits 13 description:

The bit %S13 is the bit %S94 on Modicon M340 and Premium.

When a backup in EEPROM is being, the writes are no longer operational.
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Supervision/Monitoring Window

The supervision/monitoring window is a subset of the edit window. .

It can be accessed from:
Simulation: the Mode/Simulation menu or using the simulation button on the toolbar
Monitoring: the Mode/Monitoring menu or using the simulation button on the toolbar

It contains the functions, without their connections, that the programmer extracted (using Drag/Drop or
Copy/Paste) from the edit window.
In simulation and monitoring mode, the parameters and outputs of the functions present are updated.
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